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Background

The Open Database Connectivity (ODBC) interface allows applications to access data in database management systems (DBMS) using Structured Query Language (SQL) as a standard for accessing data.

The interface permits maximum interoperability - a single application can access different database management systems.  This allows an application developer to develop, compile, and ship an application without targeting a specific DBMS.  Users can then add modules called database drivers that link the application to their choice of database management systems.

In the traditional database world, “application” has usually meant a program that performed a specific database task with a specific DBMS in mind such as payroll, financial analysis, or inventory management.  Such applications have typically been written using embedded SQL.  While embedded SQL is efficient and is portable across different hardware and operating system environments, the source code must be recompiled for each new environment.

Embedded SQL is not optimal for applications that need to analyse data stored in databases such as DB2 and Oracle, and prefer to do so from within a familiar application interface, such as Microsoft Excel spreadsheet.  Under the traditional approach to database access, one version of Microsoft Excel would have to be precompiled with the IBM precompiler and another with the Oracle precompiler, clearly a radical departure from simply buying a single packaged product.

ODBC offers a new approach: provide a separate program to extract the database information, and then have a way for applications to import the data.  Since there are, and probably always will be, many viable communication methods, data protocols, and DBMS capabilities, the ODBC solution is to allow different technologies to be used by defining a standard interface.  This solution leads to the idea of database drivers - dynamic link libraries that an application can invoke on demand to gain access to a particular data source through a particular communications method, much like a printer driver running under Windows.  ODBC provides  the standard interface that allows both application writers and providers of libraries to shuttle data between applications and data sources.

API Conformance Levels

The ODBC API defines a set of core functions that correspond to the functions in the X/Open and SQL Access Group Call Level Interface specification.  ODBC also defines two extended sets of functionality, Level 1 and Level 2.

LinkEase conforms to Level 1 API.

SQL Conformance Levels

ODBC defines a core grammar that corresponds to the X/Open and SQL Access Group CAE SQL draft specification (1991).  ODBC also defines a minimum grammar, to meet a basic level of ODBC conformance, and an extended grammar, to provide for common DBMS extensions to SQL.

LinkEase conforms to the Minimum SQL Grammar with some extensions.

SQL Optimisation, Unique Fields and Indexes

Many applications, particularly Microsoft Access, want to know about unique keys that have 'indexes' (access paths) so they can re-fetch a row using a key and be assured they gets the same record efficiently.  The key can be a set of more than one field and the index is on the set.  DataEase 4.53 cannot have an index on more than one field (that comes with compound indices in 5.x), and so the strict requirements of Access / the ODBC specification cannot be complied with.  Providing an application with the set of unique fields ensures that the application can get the record it wants, but unless that set includes an indexed field, the whole table will have to be read.  The LinkEase ODBC driver gives an application the set of fields which are unique OR indexed.  LinkEase will NOT give an application a key set of fields if none of them are unique.  When an application wants a record, it should send the driver a value for each field in the set.  LinkEase uses the index on the first indexed field to search the table for the given value in that field, and then selects the one record which matches on the unique field values from the many that may match the indexed field value.  This is the nearest to the ideal required by Access and ODBC.  If there are several indexed fields, LinkEase may not use the most efficient one - LinkEase uses the first one identified in a query (like DataEase?).  If there are unique fields, but no indexed fields, LinkEase will still give an application the set of unique fields, but there is no way of efficiently finding any record that the application might want - LinkEase will have to read the whole table!  LinkEase also give the application a separate list of indexed fields.

When Microsoft Access pages through a table that has been attached via ODBC, it issues an SQL command with a WHERE clause that ORs the values in the set of unique fields for each of the records that it wants to display in the current window.  If the set of unique fields does not include an indexed field, LinkEase will have to read every record of the attached table - every time the user tries to scroll through the table.  If the table is large, the delays can be unacceptable.  Making a field unique can seriously affect the database design, whereas adding an index to one of the existing unique fields in a DataEase 4.53 database does not affect the design - except for the possible increase in time it takes to modify or add a record.

LinkEase Advantages

LinkEase conforms to Level 1 API and Minimum SQL Grammar.  However, LinkEase also implements DATE, TIME and TIMESTAMP literals from the Extended SQL Grammar in order to allow DataEase for Windows to modify other DataEase forms / tables that contain date and / or time fields.

LinkEase is based on the well-proven DataPlus API for DataEase which has been under constant development and improvement since 1990.

LinkEase works with all versions of DataEase, pre and post 5.0, Windows as well as DOS.  New DataEase features that are implemented include Fast Text, Long Date and Compound Indices.

LinkEase handles encrypted forms / tables (including the User form) - thus maintaining the integrity of passwords and other sensitive user data.

The data administrator can strengthen data security by assigning individual users any one of seven security levels.  The assigned security level determines the forms the user can access, and which fields on a form can be viewed or modified.  LinkEase respects the access design implemented by the database administrator and only allows access to forms / tables and fields that are permitted by the Security Level associated with the user.  Thus, for example, if the database administrator intended a low-level user to only be able to add new records to, or modify existing records in, a personnel form without being able to ‘see’ the Salary field, that form can safely be offered to the same user through LinkEase.

LinkEase automatically updates all indices when a record is added, modified or deleted.

One of the most powerful uses of an ODBC driver is to combine data from more than one related table using INNER JOINS.  LinkEase optimises the access algorithm in order to use the indices on the related columns of the native DataEase database.  Without this feature, some queries would take an unacceptable time to complete.

Novell implements the shared locks needed by DataEase.  On Microsoft, and other networks, records can only be locked exclusively and DataEase has had to implement a complex shadow locking strategy to ensure that while one user is locking a record for update, other users can still read the same record. LinkEase implements the DataEase shadow locking strategy and so works with most popular network software - including Novell and Microsoft.

Installing the LinkEase ODBC Driver

You install ODBC software and the LinkEase ODBC Driver on each workstation with the ODBC setup program.  The setup program calls an installer DLL to get information about the LinkEase driver components.  Using this information, the setup program installs the driver and any related files.  Finally, it calls the installer DLL again to record information about the installed driver.

The installer DLL reads information about the driver from a setup file, SETUP.LST, and records information about the driver in the Registry.

To install and configure Microsoft Open Database Connectivity components, run the setup program (SETUP.EXE on the ODBC driver installation disk).

You are welcomed with the initial Microsoft ODBC Setup dialog box:
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After clicking on Continue, you are presented with the Install Drivers dialog box:
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The setup program builds this dialog box dynamically by reading entries in an installation file, ODBC.INF, and determines what drivers and related files are to be installed.  If you do not click on the LinkEase ODBC Driver, only the ODBC Driver Manager and associated software will be installed (or updated).  By clicking on LinkEase ODBC Driver, you will install the LinkEase ODBC Driver as well.

By clicking on the Advanced button, you are presented with the Advanced Installation Options window:
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You can set installation options such as those that disable the built-in version checking that the installer uses to ensure that older versions of drivers are not copied over newer ones and those that control whether the Driver Manager and data translators are installed.

The Versions button in this dialog box will allow you to check the versions of the ODBC components that are available in the Versions dialog box:
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After clicking on the OK button in the Install Drivers dialog box, you will see a Copying Files dialog box that keeps you informed as setup copies the relevant files from the installation disk to the Windows System directory and creates or updates the ODBC.INI file:
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Finally, the setup program displays the Data Sources dialog box which is the key to mapping drivers to data source names:
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If this is the first time that you have installed ODBC and database drivers, the list will be empty.  This dialog box is the focal point for all configuration and management of ODBC drivers and data sources.  Anything that can be done with ODBC configuration can be done from this dialog box.  This dialog box is also displayed when you run the ODBC Administrator tool or click on the ODBC icon in the Windows Control Panel.

You can see a list of installed drivers by clicking the Drivers button:
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To find out more about an installed driver, click on the driver and then on the About button:
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To add a new DataEase database source, return to the Data Sources dialog box and click on the Add button and you will be presented with the Add Data Source dialog box:
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This dialog box is similar to the earlier Drivers dialog box.  You are offered a list of database drivers, including the LinkEase ODBC Driver if you installed it earlier.  Select a driver and click the OK button.

If you have chosen the LinkEase ODBC Driver, you will then be presented with the LinkEase - ODBC Driver for DataEase Setup dialog box:
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You can click on the Browse button to search for the RDRR files associated with DataEase databases:
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Having selected a DataEase database, click on the Open button:
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If the database selected is not correct, re-click on the Browse button and try again.

Complete the entries in the LinkEase - ODBC Driver for DataEase Setup dialog box.

The Data Source Name entry is mandatory and will be used as the reference name by any ODBC compliant program that wants to access your database.

The Database Directory entry tells the driver where to find the database files.

The Database Name entry defines the name of the database as it is known to DataEase.

The User Name entry will be used by the driver when opening the database.

The Password entry will be used by the driver when opening the database.

If the User Name and / or Password entries are left empty or are invalid, the driver will prompt the user for them when attempting to access a DataEase data source.  You can use this technique to force users to ‘sign on’ to a database every time they use it.

The DataEase Directory entry is mandatory and informs the driver where the DataEase system programs and files related to the data source are located.

A completed dialog box may look like this:
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At this stage, you can accept the default options, or click on the Options button to give you access to the extended Setup screen:
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The Translate OEM to / from ANSI check box advises the driver whether to translates special characters (greater than 128 - with the high order bit set) from the OEM character set used by DOS (DataEase) programs to / from the ANSI character set used by Windows programs.

The True Unique Keys check box advises the driver whether to force a true implementation of unique keys.  In many cases, especially with DataEase 4.53 DOS databases, a related table will identify its records uniquely by two or more columns, only one of which is indexed.  Applications such as Microsoft Access will not allow tables to be updated unless they are given a set of columns which uniquely identify a record, each one of which is also indexed.  LinkEase, by default, will allow such a table to be updated by Access.  Under many circumstances, use of this option will prevent some tables from being updated.

The Read Only option check box advises the driver to treat a database as being read only even if you are licensed to use the read / write version of LinkEase.

The right hand side of the Driver Options extension contains a two column table that can be set up to automatically replace certain reserved characters in table and field names that upset some front-end applications.  Any characters from the left column found in table or field names will be replaced by the corresponding character in the right column. This translation is a two-way process - characters in the left column are converted to those in the right column as table and field names are passed to front-end applications, and vice-versa as applications pass table and field names back to LinkEase. You shouldn't translate more than one character into the same translated character, since such a translation cannot be reliably reversed. Similarly, if you translate a character into a character that has already been used in a DataEase table or field name, all occurances of that characters will be translated back

When you click on the OK button, you will return to the Data Sources dialog box.  You should now see your new Data Source Name from the LinkEase ODBC Driver Setup dialog box appearing as an entry in the Data Sources dialog box:
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You can now add further data sources or complete the installation process by clicking on the Close button:
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Using the LinkEase ODBC Driver

If you don’t register your version of the LinkEase ODBC driver, you will only be able to access the first 10 fields in the first 50 records of the first 5 User forms / tables.  You may find that you cannot log onto a DataEase database via the LinkEase ODBC driver if you use a User Name / Password that is not in the first 50 records of the Users form.

If you log onto a DataEase database via the LinkEase ODBC driver with a User Name / Password that does not have a High security level, you may find that you cannot see all the forms / tables in the database, and not all the fields in a form / table that you can see because the LinkEase driver respects the access limitations imposed by the Database Administrator of the database.

Updated DataEase control files

The system .DBS files supplied by DataEase are not always compatible with the system tables that are maintained in your database by the same version of DataEase (they might not even be supplied!).  The LinkEase ODBC driver may indicate errors when opening your database - you can ignore the errors, but you won't be able to see the internal structures of those system tables.  Likewise, the record content of system tables may sometimes indicate erroneous data.

Special versions of the DataEase system files have been provided to allow the LinkEase ODBC driver to view the system tables of your database, no matter what version of DataEase it was developed under.

You can copy RDRRFORM.DBS and REPOFORM.DBS from your release disk to the DataEase directory for any version prior to 5.

You can copy RDRRFORM.TDS and REPOFORM.TDS from your release disk to the directory for DataEase for DOS 5.

You can copy *.DFW as *.DBS from your release disk to the directory for DataEase for Windows 5.  The Locations and Masks forms are included in databases that have been converted from DataEase for DOS 4.53 - the files LOCATION.DBS and MASKFORM.DBS are needed by such converted databases.

Licensing the LinkEase ODBC Driver

All versions of LinkEase can connect with DataEase databases that are located on network servers.

The sole-user version of LinkEase exclusively locks DataEase databases making them inaccessible to other users.  The multi-user version of LinkEase is required if DataEase databases are to be shared with other users (including DataEase itself).

Each concurrent open connection to a DataEase database requires one seat.  Some front-end applications, such as Microsoft Access, release connections very slowly.  Other applications, such as DataEase Plus and NetPlus, never release connections unless the application is closed and may require a licence for several seats to satisfy all the desired database connections.

The licensing of LinkEase is based on three steps.

The first step is to run the Site Code generation program, sitecode.exe, which allows a new LinkEase user to specify the features required, and the location of a licence file.  This step creates a file, sitecode.txt, which should be forwarded to your supplier of LinkEase.

The second step is performed by Hill Croft Information Technologies.  They take the file from the first step, sitecode.txt, add a Serial Number and create a licence file, licence.txt, which will be returned to the user.

The third step is to run the registration program, register.exe, which takes the licence file and creates a control file on disk.

Defining the Site Criteria

Run the Site Code generation program, sitecode.exe, which is located on the LinkEase release disk.  This program should always be run on a workstation, not a server.  The LinkEase - ODBC Driver for DataEase - Site Code Generator dialog box will be displayed:

[image: image17.png]LinkEase

DBC Driver for DataEase

Licensee Name:

Licence Directory: Browse
© Sole User © Read Only Cancel
© Multi User © Read / Write

0K
Maximum Seats: I 16-bit I 32-bit
Site Code: |A7D33CCAE5ICDAE?-CC

e Code Generator





Enter the name of you or your organisation in the Licensee Name box:
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Enter the location of the Licence Control file in the Licence Directory box, or click on the Browse button:

If you click on the Browse button, the LinkEase - ODBC Driver for DataEase - Site Code Generator - Select a Directory dialog box will be displayed.
Select a suitable directory.  If you have purchased a Sole User licence, this directory must be located on a local hard disk.  If you have purchased a Multi User licence, this directory must be located on a network drive that is visible and allows read / write access for all potential users of the LinkEase ODBC driver - you are recommended to select the drive that is defined by the DEPATH environment variable:
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When you have selected an appropriate directory, click on the Open button.  If a licence file does not already exist in your selected directory, you will be prompted by a dialog box that requests your permission to create it:
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Click on the Yes button.  The LinkEase - ODBC Driver for DataEase - Site Code Generator dialog box will be re-displayed with the Licence Directory box containing your selected directory:
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Note that the OK button is disabled at this stage.  Select the options that you have purchased / wish to purchase.  If you click on the Sole User radio button, the Maximum Seats box will be greyed.  If you click on the Multi User radio button, you must also select one of the available Maximum Seats options.  You must also select at least one of the 16-bit or 32-bit options.  As you are entering data, the Site Code box will be constantly changing.  When you have correctly entered the required data, the OK button will be made available.

NB, the Sole User option requires a local hard disk directory and the Multi User option requires a network directory.

At this stage, you can click on the OK button, and post or E-Mail to your supplier the Site Code file, sitecode.txt, which will be found in the Licence Directory - or carefully note the contents of the dialog box (making sure about case) and forward them by FAX.
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Because you may have run sitecode.exe to upgrade an existing licence, say from sole to multi user, sitecode.exe does not overwrite an existing licence file, LinkEase.lic, nor change the reference to Licence Directory in ODBCINST.INI (16 bit) or the Registry (32 bit).  If you have difficulty using the LinkEase ODBC driver after running sitecode.exe, try deleting LinkEase.lic and the reference to Licence Directory and then re-run sitecode.exe.

Hill Croft Information Technologies will return a licence file, licence.txt, by E-Mail or FAX via your supplier. Run the Registration program, register.exe, which is located on the LinkEase release disk.  The LinkEase - ODBC Driver for DataEase Registration dialog box will be displayed with the Licence Directory box already completed:
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Either manually enter the Serial Number and Licence Number that were sent by FAX (again being very careful about case), or copy the licence file, licence.txt, to the Licence Directory and click on the Load button.  If all the boxes are completed correctly, the OK button will be enabled:
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When you click on the OK button, the licence number will be copied into LinkEase.lic in the Licence Directory.  No other users should be using LinkEase at this time.

If you change any of the details, you will have to apply for a new licence from your supplier who may make an administrative charge for the service.

Adding and Amending Data Sources

You can add new Data Sources to be used with the LinkEase ODBC Driver without running the setup program by selecting the Windows Control Panel and then double-clicking on the Administrative Tools icon:
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You can display the Data Sources dialog box by double-clicking on the Data Sources (ODBC) icon:
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To add a new DataEase database source, click on the Add button and you will be presented with the Create New Data Source dialog box:
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Select the LinkEase ODBC Driver and click the OK button:
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Complete the entries in the LinkEase - ODBC Driver for DataEase Setup dialog box and click OK:
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You will now see your new DataEase database listed in the Data Sources dialog box.

You can also amend existing data source specifications by selecting a data source in the Data Sources dialog box and clicking on the Setup button.

Using the LinkEase ODBC Driver with Microsoft Access
You can import or link tables from DataEase databases into Access databases.

Importing a table from a DataEase database creates a Microsoft Access table in the current database.  With an linked table, you can view and edit data in the DataEase database while still allowing maintenance of the table by other DataEase applications.

To import or link a DataEase database table:

Open a database, or switch to the Database window for the open database.

Click the Get External Data button from the File menu, and then choose Import… or Link Tables...
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In the Files of type dialog drop down list, select <ODBC Databases ()>:
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The Select Data Source dialog box lists the data sources for any ODBC drivers you have installed  Select the DataEase data source that contains the table(s) you want to import or link, and then choose OK.

If the User Name and / or Password associated with the data source are empty or invalid, you will be presented with the Login to Database dialog box:
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If this dialog box is presented, enter the correct User Name and Password pair and then click on the OK button.

Microsoft Access connects to the LinkEase ODBC driver and displays the list of tables in the DataEase database that you can import or attach:
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Select the table (s) you want, and click the OK button.

If you're attaching a table, select the Save password check box if you want to save the login ID and password locally.  If you leave the check box cleared, all users may have to enter the login ID and password every time they open the table in each new session with Microsoft Access.

Microsoft Access adds an attached table icon to the list of tables in the Database window.  The icon represents the link to the DataEase database table.
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If you are importing a table, Microsoft Access creates a new table named after the table you selected and imports the data from the DataEase database.

Although you can’t change the way the attached table and its fields are defined in the external database, you can set some of the properties that control the way the fields appear in Microsoft Access.
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When you open an attached table in Design  view, it looks much like a regular Microsoft Access table.
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After you link a table from a DataEase database, you can use it much like any other Microsoft Access table.  The table icon that Microsoft Access displays in the database window indicates that the data in the table is outside of your database.  Microsoft Access stores all the information you supply when linking a table so it can find the external data whenever you need it.  When you open an linked table,  Microsoft Access opens the appropriate database file or connection and displays the data.

You can also use linked tables with other database objects, such as queries, forms, and reports.  Using a query, you can join the data in the linked table with data in your Microsoft Access tables.  Even though the data may reside on a separate computer, Microsoft Access combines the data to answer your query.
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Using the LinkEase ODBC Driver with Microsoft Excel
You can retrieve external data into Microsoft Excel by using the Import External Data command in the Data menu, and then clicking on Import Data:
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The Import Data command displays the Select Data Source dialog box:
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.

Select an ODBC database and then click on the Open button:
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The Select Table dialog box enables you to select a table to import.  Double-click on any table you want to use - or click on a table and then on the OK button:
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The Import Data dialog box enables you to define a data selection query.

Click on the Edit Query… button:
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And then, the OK button.  You will be presented with the Microsoft Query window with a diagrammatic representation of the table that you have selected at the top and the first rows of data in the table below:
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You can refine your query by limiting the records that will be selected.  If you click on the Criteria menu and the Add Criteria option, you will be given another section in the window that you can use to enter any criteria that you wish to specify:
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Select a Field and then enter your criteria Operator and Value in the boxes underneath.  You can now click on the Add button to have your query executed.  You can refine your query by adding more criteria, or click on the Close button to have the results presented in the bottom part of the window:
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Finally, you might want to order the results.  Click on a field name above a column in the lower part of the window so that it is displayed in reverse video, then click on one of the sort buttons in the toolbar:
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You can click on any unwanted columns in the result set and then your Delete key:
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You can now view the SQL query statement that has been generated by Microsoft Excel by clicking on the SQL button in the toolbar:
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When you finish building a query, return the result set to your Microsoft Excel worksheet by selecting Return Data to Microsoft Excel command in the File menu:
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When you return data to Microsoft Excel, you confirm or change the destination on the worksheet where you want to place the result set.  If you do not change the destination, Microsoft Excel uses the active cell as the destination:
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Now you can click on the OK button and the Import Data dialog box will be removed and you will be left with the main Microsoft Excel window with ‘Getting data ...’ in the lower left corner of the window while Microsoft Excel is retrieving the result set via DDE, Microsoft Query and the LinkEase ODBC driver.
When all the data has been retrieved, the Microsoft Excel window might appear thus:
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Using the LinkEase Driver with DataEase for Windows

DataEase for Windows can be used as a front-end tool in a Client-Server environment to link to SQL databases (including other DataEase databases via the LinkEase ODBC driver).

You link to tables from DataEase databases by choosing Application -> Database Links from the Menu bar.

You are then presented with the Database Links Dialog box:
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Link Name lets you assign a name to the database.  The Link Name is used to refer to the database from within your application.  You may want to use the actual database name as specified on the server or a more descriptive name.

Engine Type tells DataEase the type of engine that stores the database you want to link to your application.  When you click on the Engine Type drop-down arrow, DataEase lists all the engine types it supports.  Choose Other Engines via ODBC.

You must use the ODBC Administrator tools to set up your ODBC data sources before you can create a DataEase database link.

Server Name tells DataEase the name of the name of the server that stores the database that you want to link to your application.  This must be entered exactly as the Database Name field.

Database Name tells DataEase the name of an existing database you want to link to your application.  Enter the name of the DataEase database that you want to link to via ODBC.

Add saves the link from your application to the external DataEase database.

Complete these sections of the dialog box:
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Then press the Add button.  DataEase for Windows uses the Username and Password that was used to log onto your DataEase for Windows application when first attempting to log onto the external DataEase database via ODBC.  If this is not a valid Username and Password for the external database, the LinkEase ODBC Driver uses the User Name and Password associated with the data source.

If the User Name and / or Password associated with the data source are empty or invalid, you will be presented with the Login to Database dialog box:
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If requested, enter the correct User Name and Password that will give you the appropriate access rights to the external database and then click on the OK button.

If you press the OK button and you have entered a valid User / Password, you will return to the Database Links dialog box.

When you add a link, DataEase for Windows automatically lists the tables in the specified database in the Tables Available box.  Select the tables you want to use:
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Build Forms lets you select multiple tables at one time to use with your application.  This is faster than selecting tables one at a time using the New Document dialog.

Done closes the Database Links dialog and returns you to the main DataEase for Windows dialog.

If you now double click on your newly linked external DataEase database, you will get a list of all the tables in the database that you have selected:
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You can now access the external DataEase database tables in the same way that you access native DataEase for Windows tables.  For example, by double clicking on Members, you get a similar view to that shown above with Access:
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